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1. Einleitung

Vielen Dank, dass Sie sich für ein Beschallungssystem aus unserem Hause entschieden haben. Bitte lesen
Sie sich vor Inbetriebnahme die Gebrauchsanweisung sorgfältig durch, damit ein störungsfreier Betrieb
gewährleistet ist. Als Besitzer der CON:SEQUENZA Software haben Sie nun ein sehr vielseitiges und
hochprofessionelles Werkzeug an der Hand, das Ihnen, bei richtiger Bedienung, viel Freude bescheren
wird.

1.1 Symbole�im�Handbuch

Warnung

Dieses Symbol bedeutet eine möglicherweise drohende Gefahr für das Leben und die Gesundheit von
Personen. Das Nichtbeachten dieser Hinweise kann schwere gesundheitliche Auswirkungen zur Folge
haben, bis hin zu lebensgefährlichen Verletzungen.

Vorsicht

Dieses Symbol bedeutet eine möglicherweise gefährliche Situation. Das Nichtbeachten dieser Hinweise
kann leichte Verletzungen zur Folge haben oder Sachbeschädigungen hervorrufen.

Tipp

Dieses Symbol gibt Hinweise für den einfacheren Umgang mit den beschriebenen Produkten.

In diesem Handbuch sind alle Programmelemente die für die Bedienung wichtig sind in eckige Klammern
'[ ]' gesetzt.

Tastenkombinationen (Shortcuts) zum Ausführen des entsprechenden Befehls werden in " " gesetzt.

1.2 Informationen�über�dieses�Handbuch

Softwarehandbuch CON:SEQUENZA.

© Kling & Freitag GmbH, 2008, alle Rechte vorbehalten.

Sämtliche Angaben in diesem Handbuch basieren auf den zum Zeitpunkt der Drucklegung verfügbaren
Informationen über die Eigenschaften der hier beschriebenen Produkte und den entsprechenden Sicher-
heitsvorschriften.

Der Hersteller behält sich Änderungen und Modifikationen im Rahmen der gesetzlichen Bestimmungen
sowie die Verbesserung der Produkteigenschaften ausdrücklich vor.

Diese�Anleitung�und�alle�weiteren�notwendigen�Informationen�zum�sicheren�Gebrauch�müssen
allen�Personen,�die�das�Lautsprechersystem�benutzen,�zum�Zeitpunkt�des�Auf-�und�Abbaus
und�während�des�Betriebs�verfügbar�sein!

Wir freuen uns über Anregungen und Verbesserungsvorschläge zu diesem Handbuch. Bitte schicken Sie
diese an folgende Adresse:

info@kling-freitag.de oder an:

KLING & FREITAG GMBH Junkersstr.14 D-30179 Hannover.

Telefon 0511 - 96 99 70, Telefax 0511 - 67 37 94.
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2. Systemvoraussetzungen

Betriebssysteme

• Windows XP, SP2 oder SP3

• Windows Server 2003, SP2 oder SP3

• Windows Vista SP1

• Windows Server 2008

Prozessoren

• Intel Pentium 4 und höher

• Intel Celeron 1.7 Ghz und höher

• Intel Xeon

• Intel Core

• AMD Opteron

• AMD Sempron

• AMD Athlon 64 (mit SSE2)

Speichervoraussetzungen

• mindestens 512 MB RAM (1024 MB empfohlen)

• mindestens 700 MB freier Speicher auf der Festplatte

Bildschirmauflösung

• Der Bildschirm muss eine Bildschirmauflösung von mindestens 1024 x 768 darstellen können.

Software

• Zur ordnungsgemäßen Funktion der K&F CON:SEQUENZA Software ist die einmalige Installati-
on der Matlab Compiler Runtime Version 7.9 (MCR) von The Mathworks Inc. zwingend erforder-
lich. Die MCR ist im Installationspaket der CON:SEQUENZA Software enthalten. Die Kompatibili-
tät der K&F CON:SEQUENZA Software mit anderen Versionen der MCR, Früheren oder Späteren
oder auch aus anderen Quellen, ist nicht gewährleistet.
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3. Installation

Um das K&F CON:SEQUENZA Softwarepaket zu installieren,
starten Sie die "ConSequenza Setup.exe" und folgen Sie den Installationsanweisungen.

Wenn der Installer feststellt, dass die notwendige Matlab Compiler Runtime Version 7.9 (MCR) noch
nicht auf Ihrem Rechner installiert ist, wird diese installiert.

Während einer MCR Installation werden Sie gefragt, ob Sie Microsoft .Net Framework installieren möch-
ten. Für die Funktion der K&F CON:SEQUENZA ist Microsoft .NET Framework jedoch nicht erforderlich.
Klicken Sie daher im entsprechenden Fenster zur .NET Framework Installation auf "OK" um die Instal-
lation zu überspringen.

3.1 Programm�starten

Sie können die Software auf folgende Arten starten:

• Falls Sie bei der Installation ein Desktop-Symbol erstellt haben, genügt ein Doppel-Klick auf das
Consequenza-Symbol.

• Falls Sie bei der Installation ein Symbol in der Windows-Schnellstartleiste erstellt haben, genügt
ein Klick auf das Consequenza-Symbol in der Schnellstartleiste.

• Starten Sie die Software im Windows Startmenü über 'Programme' - 'KlingFreitag Consequenza'
- 'Consequenza'.

Bitte beachten Sie, dass der Start des Programms, je nach Rechner, einige Zeit dauern kann.

3.2 Deinstallation

Zur Deinstallation benutzen Sie bitte die Softwareverwaltung unter Windows.
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4. Übersicht�der�Bedienelemente

4.1 Hauptbildschirm

4.1.1 Hauptbereiche�des�Bildschirms

1. [Plane Editor] = Bereich zum Einrichten von Hörerflächen

2. [Project Name] = Name des geladenen Projektes

3. [Microphone Simulation] = Bereich zum Einrichten der Frequenzgang-Simulation

4. [Array Setup] = Bereich zum Einrichten der Arrays

5. [Simulation Results] = Bereich zur Anzeige des Simulationsergebnisses

6. [Splay Configuration] = Bereich zur Anzeige und Änderung der Array Konfiguration

4.1.2 Bedienelemente�auf�dem�Bildschirm

[Add Plane] = Hörerfläche hinzufügen

[Drop down Liste] im Bereich 'Plane Editor' = Auswahl einer Hörerfläche

[Delete Plane] = Hörerfläche löschen

[Block] im Bereich 'Plane Editor' = Bearbeiten der Hörerfläche sperren und Simulation der Pegelvertei-
lung unterdrücken

[Offset on X-Axis] = Seitlicher Versatz der Hörerfläche zum Referenzpunkt (0-Punkt)

[Ear level] = Ohrhöhe: Abstand zur Hörerfläche z.B. sitzend oder stehend

[Plane FRONT] = Höhe und Breite der Hörerflächenvorderkante und ihre Entfernung zum 0-Punkt auf
der Y-Achse.

[Plane REAR] = Höhe und Breite der Hörerflächenhinterkante und ihre Entfernung vom 0-Punkt auf der
Y-Achse

[Project Name:] = Eingabefeld für den Projektnamen

[Add] im Bereich 'Microphone Simulation' = Mikrofon für Mikrofonsimulation hinzufügen
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[Delete] im Bereich 'Microphone Simulation' = Mikrofon für Mikrofonsimulation entfernen

[Add] im Bereich 'Array Setup' = Array hinzufügen

[Drop down Liste] im Bereich 'Array Setup' = Auswahl eines Arrays

[Delete] im Bereich 'Array Setup' = Ausgewähltes Array löschen

[Block] im Bereich 'Array Setup' = Bearbeiten des ausgewählten Arrays sperren und Simulation der
Pegelverteilung unterdrücken

[Stacked] = Gestapeltes Array

[Flown two-strands] = Array 2-strängig geflogen

[Flown one-strand] = Array 1-strängig geflogen

[No. of Cabinets] = Anzahl der Lautsprecher

[Flying Frame top / bottom front] = Position der oberen/unteren Flugrahmenvorderkante relativ zur 0,
0, 0 Koordinate (Referenzpunkt)

[Azimuth] = Array-Ausrichtung horizontal

[Auto Splay] = Splay Configuration vorschlagen: Vorschlag zur Winkelung der Lautsprecher und Neigung
des gesamten Arrays für die gewählte Anzahl und Art der Lautsprechermodelle.

[Array Gain] = Verstärkung für das gewählte Array einstellen.

[Array Delay] = Delay für das gewählte Array einstellen. Wahlweise können die Einheiten ms oder m
verwendet werden (Menü: Settings -> Array Delay in ->)

[Speaker Model] = Lautsprechermodel für den gewählten Lautsprecher definieren

[Cardioid] = Subwoofer für Cardioid- oder Hypercardioidanwendung nach hinten drehen (die Funktion
steht nur bei Anordnungen aus 3, 6, 9 oder 12 Subwoofern zur Verfügung).

[Drop down Liste] im Bereich 'Splay Configuration' = Auswahl einzelner Lautsprecher

[Splay Angle] = Winkel der gewählten Lautsprecher zueinander. Beim obersten Lautsprecher (flown)
bzw. beim untersten Lautsprecher (stacked) Absolutwinkel des Flugrahmens.

[Calculate] = Simulation starten

[Full Plane(s) [3D]] = Berechnung der Schallabdeckung für die gesamte Hörerfläche

[Drop down Liste] im Bereich 'Simulation Results' = Anzeige bereits simulierter Frequenzen.

[Frequency] = Auswahl Frequenz. Die Frequenz, die berechnet werden soll, können Sie in das Feld
eintragen oder mit den Pfeil-Buttons in Terzen und mit dem Scrollbalken kontinuierlich einstellen.
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4.2 Übersicht�der�Menüstruktur

Open… "Strg + O" Öffnet eine Datei.

Save Plane(s)… Speichert die erstellten Hörerflächen und
Mikrofone.

Save Array(s)… Speichert alle Arrays.

Save Venue… Speichert das komplette aktuelle Projekt ab,
inklusive Hörerflächen, Array Setup und Mi-
krofonen (Microphone Simulation).

Export to Ease > Öffnet ein Untermenü für den Export der
Arrays und Hörerflächen als Dateien für
das Simulationsprogramm EASE. Sie kön-
nen auswählen, ob Sie ein einzelnes Array,
alle Arrays oder alle Arrays und Hörerflä-
chen exportieren möchten. Detaillierte In-
formationen zum EASE Export finden Sie in
Kapitel 22

File

Close/Quit program "Strg + Q" Beendet das Programm

Project Name Ändern des Projektnamens

Array (only active) Setzt alle Winkel des ausgewählten Arrays
auf Null und alle Lautsprecher auf das Mo-
del 10N.

Plane(s) Löscht alle Flächen (Planes).

Microphone(s) Löscht alle Mikrofone.

Edit

Reset ->

All Führt die Befehle 'Reset: Array', 'Reset: Pla-
nes' und 'Reset:Microphones' aus.

Setup Plot… "Srtg + P" Öffnet ein Fenster mit dem Setup Plot zum
Ausdruck

SPL Simulations… "Strg + L" Öffnet ein Fenster mit dem Simulationser-
gebnis zum Ausdruck

Mic-Simulations… "Strg + M" Öffnet ein Fenster mit dem gesamten Fre-
quenzgang an den erstellten Mikrofonposi-
tionen.

Mic-Sim. REFERENCE… Ermöglicht ein Mikrofon als Referenz zu
wählen

View

Multi Array... "Strg + A" Öffnet ein Fenster zum Unterdrücken oder
Aktivieren der Pegelsimulation einzelner Ar-
rays.

Array -> Ermöglicht das Array im Fensterbereich
'Splay Configuration' in verschiedenen pla-
naren Ansichten zu zeigen.

Plane -> Ermöglicht die Zuhörerfläche im Fensterbe-
reich 'Plane Editor' in verschiedenen plana-
ren Ansichten zu zeigen.

3D-View

Venue -> Ermöglicht das Simulationsergebnis im Fen-
sterbereich 'Simulation Results' in verschie-
denen planaren Ansichten zu zeigen.

Array Array hinzufügen

Duplicate Array ausgewähltes Array kopieren und an ge-
wünschter Position einfügen

Plane Zuhörerfläche hinzufügen

Add

Microphone Mikrofon hinzufügen



Softwarehandbuch K&F CON:SEQUENZA

KLING & FREITAG GMBH © 2008 Version 3.0 Seite 11 von 24

Calculate 21 Frequencies Ermöglicht das gesamte Frequenzspektrum
von 100 Hz bis 10 kHz in Terz-Intervallen
mit einem Befehl zu simulieren (21 Frequen-
zen). Dieser Vorgang nimmt einige Zeit in
Anspruch.

Atmospheric... Öffnet ein Fenster, in dem Sie die voreinge-
stellten Angaben zum Luftdruck, zur Luft-
feuchtigkeit und zur Temperatur verändern
können. Über die Schaltfläche [Calculate
atmospheric attenuation] können Sie ent-
scheiden, ob die Schallabschwächung, die
aus Luftdruck und Luftfeuchtigkeit resul-
tiert, bei der Berechnung der Schallvertei-
lung berücksichtigt werden soll.

Array Delay in -> Öffnet ein Untermenü in dem Sie auswäh-
len können, ob Sie das Array Delay im Fen-
sterbereich Splay Configuration im ms oder
in Metern angeben möchten. Wenn Sie Me-
ter wählen, ist dieser Wert von der gewähl-
ten Temperatur abhängig, die Sie unter Set-
tings ->Atmospheric..' einstellen.

Shot points on Plane Hiermit aktivieren Sie, dass die Strahlach-
sen der einzelnen Arrayelemente im Be-
reich [Simulation Results] auf die Hörerflä-
che auftreffen. Bei der Verwendung von
Laserpunkten zur Einrichtung eines Arrays
kann es sinnvoll sein, die Auftreffpunkte auf
die Hörerflächen zu setzen um eine bessere
Kontrolle der Einrichtung zu ermöglichen.

Settings

Shot points on Ear level Hiermit aktivieren Sie, dass die Strahlachsen
der einzelnen Arrayelemente im Bereich [Si-
mulation Results] auf die Hörerfläche auf-
treffen.

Help Zugriff auf das Handbuch
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5. Projekte�anlegen,�öffnen�und�speichern

Die CON:SEQUENZA Software wird mit einer Beispielkonfiguration ausgeliefert. Wenn Sie die Software
das erste Mal öffnen, wird automatisch der Ordner für die Beispielkonfiguration geladen. Wenn Sie die
Software schließen und erneut öffnen, wird der jeweils letzte Speicherort geöffnet.

5.1 Vorhandenes�Projekt�öffnen

1. Klicken Sie auf [File] > [Open].

2. Wählen Sie die gewünschte Datei aus.

• Wenn Sie ein Venue (komplette Konfiguration mit Hörerfläche(n), Mikrofon(en) und Array öff-
nen, wird ein komplettes Projekt mit Hörerfläche(n), Mikrofon(en) und Array geladen.

• Wenn Sie ein Array (Lautsprecher-Konfiguration) öffnen, wird nur das Array geladen und die
aktuelle Hörerfläche wird nicht verändert.

• Wenn Sie ein Plane (Hörerfläche) öffnen, wird nur die Zuhörerfläche geöffnet und das aktuel-
le Array wird nicht verändert.

5.2 Projektnamen�ändern

Im Feld [Project Name] können Sie einen neuen Projektnamen eintragen. Wenn Sie das Project, das Array
oder die Planes speichern, wird dieser Eintrag als Namensvorschlag verwendet.

Alternativ können Sie den Projektnamen im Menü auch unter Edit�>�Project�Name� ändern.

Wenn Sie 'Planes', 'Array' oder 'Venue' speichern, wird der hier eingetragene Name als Dateiname vor-
geschlagen.

5.3 'Arrays',�'Planes'�oder�'Venue'�speichern

1. Klicken Sie auf [File] > [Save Plane(s)…], [Save Array(s)…] oder [Save Venue….].

2. Geben Sie den gewünschten Dateinamen an oder übernehmen Sie den Vorschlag.

• Wenn Sie [Save Venue…] wählen, wird das komplette Projekt mit Hörerflächen (Planes), Ar-
rays, Mikrofonen (Microphone Simulation) und Simulationsergebnissen gespeichert. Dabei
werden auch die Simulationsergebnisse für Schallverteilung und Mikrofonsimulationen ge-
speichert.

• Wenn Sie [Save Plane(s)…] wählen, werden die Hörerflächen (Planes) und Mikrofone gespei-
chert.

• Wenn Sie [Save Array(s)…] wählen, werden nur die Arrays gespeichert.

5.4 Dateispeicherorte

Standardmäßig werden alle speicherbaren Dateien (Venue, Array, Planes, Setup Plot und SPL Simulation)
unter folgenden Pfaden gespeichert:

Windows�2000,�XP

• "C:\Dokumente und Einstellungen\'Benutzername'\Eigene Dateien\KlingFreitag\ConSequenza\",
wenn Sie die Installation nur�für�sich durchgeführt haben.

• "C:\Dokumente und Einstellungen\All Users\Dokumente\KlingFreitag\ConSequenza\", wenn Sie
die Installation für�alle�Benutzer durchgeführt haben.
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Windows�Vista

• "C:\Users\'Benutzername'\Documents\KlingFreitag\ConSequenza\", wenn Sie die Installation
nur�für�sich durchgeführt haben.

• "C:\Users\Public\Documents\KlingFreitag\ConSequenza\", wenn Sie die Installation für�alle�Be-
nutzer durchgeführt haben.

Diesen Pfad können Sie ändern, die Software speichert den neuen Speicherort und wählt beim nächsten
Öffnen/Speichern den zuletzt von Ihnen verwendeten Pfad.

6. Hörerflächen�und�Arrays

6.1 Maßeinheiten

Tipp

Alle Entfernungen werden in Meter [m] angeben. Sie können die Werte entweder als Zahl über die
Tastatur eingeben oder Sie mit den Pfeiltasten oder dem Scrollrad einer Maus erhöhen oder verringern.

Sämtliche Werte, die Sie zur Lage der Hörerflächen, des Arrays etc. eingeben, beziehen sich auf den 0-
Punkt (0, 0, 0) im X,Y,Z Koordinatensystems (Referenzpunkt).

6.2 Hörerfläche�einrichten,�bearbeiten�und�löschen�(Plane�Editor)

1. Klicken Sie auf die Schaltfläche [Add Plane] um eine neue Hörerfläche einzurichten.

Geben Sie in das Editierfeld einen Namen für die Hörerfläche ein oder übernehmen Sie den Vor-
schlag.

2. Geben Sie unter [Offset on X-Axis] den Abstand der Flächenmitte zum 0-Punkt auf der X-Achse ein.

3. Geben Sie unter [Ear Level] die Ohrhöhe der Zuschauerohren über der Hörerfläche an, je nach dem
ob die Zuhörer sitzen oder stehen. Dies ist die Höhe für die die Simulation die Beschallung berechnet.
Die Höhe der Zuhörerohren wird als gestrichelte Linie dargestellt.

4. [Plane FRONT]

Die Werte, die Sie hier einsetzen beziehen sich auf den Boden der Hörerfläche.

Definieren Sie im Bereich [Plane FRONT] die vordere Kante der Hörerfläche.

• Geben Sie unter [Width] die Breite der Flächenvorderkante ein.

• Geben Sie unter [Height] die Höhe der Flächenvorderkante über dem 0-Punkt ein.

• Geben Sie unter [Position on Y-Axis] den Abstand der Flächenvorderkante zum 0-Punkt auf
der Y-Achse ein. Verwenden Sie positive oder negative Werte für die entsprechenden Seiten.

5. [Plane REAR]
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Die Werte, die Sie hier einsetzen beziehen sich auf den Boden der Hörerfläche. Definieren Sie im
Bereich [Plane REAR] die hintere Kante der Hörerfläche.

• Geben Sie unter [Width] die Breite der Flächenhinterkante ein.

• Geben Sie unter [Height] die Höhe der Flächenhinterkante über dem 0-Punkt ein.

• Definieren Sie unter [Position on Y-Axis] die Länge der Hörerfläche. Die Gesamtlänge beträgt
Wert aus 'Position on Y-Axis Plane REAR' - Wert aus 'Position on Y-Axis Plane FRONT'.

6. Weitere Hörerflächen anlegen

Gehen Sie wie ab Punkt 1 beschrieben vor.

7. Selektierte Hörerfläche löschen

Klicken Sie auf [Delete Plane].

8. Hörerfläche sperren

Klicken Sie auf [Block].

Daraufhin werden die Felder für die Werte ausgegraut und sind vor versehentlichen Änderungen
geschützt. Ebenso werden die geblockten Planes nicht mitberechnet. Dies spart Rechenzeit beim
Einrichten eines Projekts.

6.3 Arrays�einrichten�(Array�Setup)

1. Klicken Sie im Bereich 'Array Setup' auf die Schaltfläche [Add], um ein neues Array einzurichten.

2. Wählen Sie unter [Stacked] bzw. [Flown two-strands] / [Flown one-strand], ob das Array gestapelt
bzw. an einem oder zwei Strängen geflogen werden soll.

Mit den Schiebereglern unter Flown two-strands / Flown one-strand können Sie im Modus 'Flown
two-strands' die Position der Ketten bei einer zweisträngigen Aufhängung verändern. Beachten
Sie�dabei,�dass�die�Belastungsvorgaben�der�anwendbaren�Normen�eingehalten�werden
müssen,�um�einen�sicheren�Betrieb�zu�gewährleisten!

3. Geben Sie im Bereich 'Array Setup' unter [No. of Cabinets] die Anzahl der Lautsprecher ein, die
Sie verwenden wollen. Die Software begrenzt die Anzahl der Lautsprecher, je nach verwendeten
Lautsprechertyp, auf zulässige Anzahl.

4. Wählen Sie im Bereich 'Splay Configuration' unter [Speaker Model] das gewünschte Lautsprecher-
model für den gewählten Lautsprecher aus.

TIPP:�Wenn�Sie�das�Model�10�B�für�einen�Lautsprecher�wählen,�werden�alle�Lautsprecher
oberhalb�dieses�Lautsprechers�ebenfalls�zum�Modell�10�B.

Der jeweils ausgewählte Lautsprecher ist rot dargestellt.

Um einen Lautsprecher auszuwählen, klicken Sie mit der Maus auf den dargestellten Lautsprecher
oder sie wählen ihn aus der Dropdown-Liste unter [Cabinet].

TIPP:�Durch�gleichzeitiges�Drücken�der�Umschalttaste�und�bewegen�der�Maus�mit�Linksklick
in�der�Array�Fläche�im�Bereich�[Splay�Configuration]�können�Sie�das�Array�im�Orbit�frei
bewegen�(alternativ:�mittlere�Maustaste�ohne�Umschalttaste).

5. Wenn Sie 3 Subwoofer oder ein vielfaches von 3 Subwoofern in ihr Array integriert haben, so können
Sie die Option [Cardioid] wählen, um die jeweils mittleren Lautsprecher der 3er Einheiten für eine
Cardioidanwendung nach hinten zu drehen.

6. Definieren Sie im Bereich [Array Setup] den Bezugspunkt des Arrays. Der Bezugspunkt bestimmt die
Lage des Arrays in Bezug auf den 0-Punkt des Koordinatensystems im Raum. Er liegt im geflogenen
Aufbau in der Mitte der oberen, vorderen Kante des Flugrahmens, im gestackten Aufbau in der
Mitte der unteren, vorderen Kante.

• Geben Sie unter [Height] die Höhe des Arrays über dem 0-Punkt ein.

• Geben Sie unter [Position on X-Axis] den Abstand des Arrays vom 0-Punkt auf der X-Achse
ein. Verwenden Sie positive oder negative Werte für die entsprechenden Seiten.

• Geben Sie unter [Position on Y-Axis] den Abstand des Arrays zum 0-Punkt auf der Y-Achse an.

• Geben Sie unter Azimuth einen positiven oder negativen Winkel ein, um das Array horizontal
zu drehen.
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Der Bezugspunkt ist im Fenster unter View > Setup Plot durch ein rotes Dreieck am Flugrahmen
markiert.

6.3.1 Neigungswinkel�einrichten�(Splay�Configuration)

Warnung

Gefahr durch herabstürzende oder kippende Arrays oder Lautsprecher! Achten Sie darauf, mit den
angegebenen Winkeln die zulässigen Lasten der hinterlegen Normen (BGV C1, DIN 18800) nicht zu
überschreiten. Dies wird in der CON:SEQUENZA Software durch 2 grüne Balken mit der Beschriftung
"BGV C1 OK" und "Load OK (DIN18800)" angezeigt. Sorgen Sie ggf. für die notwendigen Siche-
rungsmaßnahmen.

Für�einen�sicheren�Betrieb,�sind�die�Angaben�der�Software�unbedingt�einzuhalten!

• Wenn Sie das Array fliegen, können Sie die Schaltfläche [Auto Splay] verwenden, um sich einen
Vorschlag für den Winkel des Arrays und die Einstellwinkel der einzelnen Lautsprecher unterbrei-
ten zu lassen. Die Software berücksichtigt dabei eine möglichst gute Schallabdeckung für die
eingerichteten Hörerflächen. Die Berechnung sucht außerdem die optimalen Positionen der La-
stadapter und gibt als Winkel ein Ergebnis aus, das so nah wie möglich am theoretisch optima-
len Winkel liegt. Bitte beachten Sie, dass unter realen Bedingungen und den daraus resultieren-
den Einflüssen eine manuelle Feinabstimmung sinnvoll ist.

• Wenn Sie das Array stapeln, müssen Sie die Neigungswinkel der einzelnen Lautsprecher manuell
eingeben. Wählen Sie dazu den jeweiligen Lautsprecher aus der Dropdown-Liste und geben Sie
im nebenstehenden Feld den Neigungswinkel ein.

• Siehe auch Kapitel "Ergebnis optimieren" auf Seite 18.
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6.4 Array�Konfiguration�ansehen�(Splay�Configuration)

Im Bereich [Splay Configuration] werden die aktuellen Einstellungen für das Array wiedergegeben.

In der Dropdown-Liste unter Cabinet sind die verwendeten Lautsprecher aufgelistet. Der jeweils ausge-
wählte Lautsprecher ist rot dargestellt. Daneben ist jeweils der Lautsprechertyp, die Winkelung und der
zu verwendende Controller sowie die Verkabelung angegeben.

Anhand der beiden Balken unter der Dropdown-Liste können Sie erkennen ob das Array für einen siche-
ren Betrieb eingerichtet ist. Wenn die Balken grün sind, werden die angegebenen Standards eingehalten.

Das Diagram bildet das aktuelle Array ab. Im oberen Teil des Diagrams sind die Lasten an den Ketten
angegeben.

Warnung

Diese�Angabe�bezieht� sich�nur�auf�die�Last�der�Lautsprecher�und�den�Flugrahmen�am�/�an
den�Lastadapter/n.�Das�Gewicht�von�Kabelbäumen,�Ketten�und�Anschlagmitteln�bleibt�bei�der
Berechnung�dabei�aber�unberücksichtigt.�Dies�müssen�Sie�beachten,�wenn�Sie�prüfen,�ob�der
gewählte�Aufhängepunkt�die�Last�aufnehmen�kann!
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7. Simulation

7.1 Simulation�anzeigen�(Simulation�Results)

Eine�Schallsimulation�für�die�Subwoofer�SEQUENZA�10�B�ist�noch�nicht�in�die�Software�imple-
mentiert.�Es�wird�lediglich�die�Schallausbreitung�für�die�Topteile�SEQUENZA�10�N�und�SEQUEN-
ZA�10�W�simuliert!

Tipp

Durch Drücken der Umschalttaste und gleichzeitiges Bewegen der Maus mit Linksklick im Venue-Fen-
ster im Bereich [Simulation Results] können Sie die Anzeige im Orbit frei bewegen (alternativ: mittlere
Maustaste ohne Umschalttaste).

Klicken Sie auf [Calculate], um die Simulation zu starten.

Als Ergebnis wird die gesamte Schallabdeckung der Zuhörerfläche angezeigt. Die Subwoofer werden
dabei jedoch nicht simuliert!

Die Farbskala zeigt den jeweiligen maximalen Schalldruck in dB/SPL. Die Zahlen an der Farbskala auf der
Zuhörerfläche geben den zentralen Zielpunkt des jeweiligen Lautsprechers an.

Wenn Sie [Full Plane(s) [3D]] deaktivieren, wird die das Simulationsergebnis lediglich entlang der Mitte-
lachse der Lautsprecher dargestellt. Mit dieser Option lässt sich Rechenzeit deutlich reduzieren.

Beachten Sie dabei, dass es sich bei dem Simulationsergebnissen nur um theoretisch ermittelte Werte
handelt. Messen Sie diese Werte gegebenenfalls nach.

Sie können die angezeigte Frequenz mit dem Schieberegler im unteren Bereich des Bildschirms ändern.
Alternativ können Sie auch den gewünschten Wert in das entsprechende Feld eingeben.

Um�die�Beschallung�auf�der�neuen� Frequenz�anzuzeigen,�müssen�Sie�die� Simulation�durch
Klicken�auf�[Calculate]�neu�starten.

In der [Drop down Liste] im Bereich 'Simulation Results' können Sie die bereits simulierten Frequenzen
zur Anzeige auswählen.
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7.1.1 Gesamten�Frequenzgang�zeigen�(Microphone�Simulation)

Zusätzlich können Sie im Bereich [Microphone Simulation] einzelne Punkte definieren an denen dann
der gesamte Frequenzgang simuliert und dargestellt wird.

1. Klicken Sie auf [Add (Microphone Simulation)].

2. Geben Sie in dem Fenster einen Namen für das Mikrofon ein oder übernehmen Sie den Vorschlag.

3. Klicken Sie auf [OK].

Daraufhin verwandelt sich der Mauszeiger in ein Fadenkreuz und Sie können das Mikrofon im Be-
reich 'Simulation Results' platzieren.

• Im unteren Feld des Bereichs 'Microphone Simulation' können Sie die Position in Metern ein-
geben. Diese Eingabe müssen Sie in eckige Klammern setzen und die einzelnen Zahlen durch
Leerzeichen voneinander trennen, z.B. [1 2 3].

Bei Bedarf können Sie die Position des Mikrofons ändern. Geben Sie dazu die gewünschten Werte in die
Felder Height, Position on X-Axis und Position on Y-Axis ein.

Sie können ein positioniertes Mikrofon als Referenz für andere Mikrofone bestimmen. Dazu gehen Sie in
das Menü [View] und wählen [Mic-Sim. REFERENCE...]. Anschließend wählen Sie das Mikrofon aus dem
Dropdown Menü, das Sie als Referenz bestimmen möchten. Alternativ könne Sie auch im Microphone
Simulations Fenster mit der rechten Maustaste auf die Mikrofonkurve klicken, die Sie als Referenz setzen
möchten und [Choose as Reference...] wählen.

Nachdem Sie ein Mikrofon als Referenz gewählt haben, erscheint das Fenster [Microphone Simulations...
REFERENCE], auf dem Sie die Pegelabweichungen der gesetzten Mikrofone zum Referenzmikrofon be-
trachten können.

8. Ergebnis�optimieren

Nach der Auto Splay Berechnung können Sie die Ergebnisse durch nachträgliches Verändern des Arrays
noch weiter optimieren. Wenn Sie einzelne Bereiche (Zuhörerflächen, Arrays etc.) ändern, werden jeweils
nur die Änderungen neu berechnet nicht das gesamte Projekt.

Um�das�Ergebnis�insgesamt�zu�aktualisieren,�müssen�Sie�erneut�auf�[Calculate]�klicken!

Warnung

Achten�Sie�darauf,�dass�die�Ergebnisse�der�statischen�Berechung�im�zulässigen�Bereich�liegen
(grüner�Balken,�schwarze�Lastangaben).

Die Vorgaben und Ergebnisse der Software sind unbedingt zu berücksichtigen.

Die Anhängelast wird ohne das Gewicht der Kabel oder sonstigen Anbauten angegeben.

1. Um das Array anzupassen, können Sie folgende Einstellungen ändern:

• Verändern Sie den Wert für [No. Cabinets], um Lautsprecher hinzuzufügen oder zu entfernen.

• Verändern Sie den Wert für [Azimuth], um das Array zu drehen.

• Verändern Sie den Wert für [Splay Angle], um den Winkel des gewählten Lautsprechers anzu-
passen. Um die Einstellwinkel anzupassen können Sie die einzelnen Lautsprecher auswählen,
in dem Sie mit dem Mauszeiger darauf klicken oder Sie aus der Dropdown-Liste Cabinet aus-
wählen. Der jeweils ausgewählte Lautsprecher ist rot dargestellt.

• Verändern Sie den Lautsprechertyp in der Dropdown-Liste neben dem Eingabefeld.
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9. Auswertung

9.1 Setup�Plot

Sie können die Konfiguration des Arrays in einem separaten Fenster anzeigen und daraus ein PDF erzeu-
gen, um z.B. einen Ausdruck für am Aufbau beteiligtes Personal zu erstellen.

1. Gehen Sie im Menü auf [View -> Setup Plot], um sich das detaillierte Setup Ergebnis mit Lastangaben
Winkelungen und Controllerzuweisungen anzeigen zu lassen.

Hier bekommen Sie auch eine deutliche grafische Ansicht an welchen Bohrungen des Flugrahmens
die Lastadapter gesetzt werden müssen.

2. Mit der Schaltfläche [Create PDF] können Sie ein PDF des Setups erzeugen.

Wenn Sie Änderungen im Bereich 'Array Setup' oder 'Splay Configuration' vornehmen, wird der Setup
Plot automatisch aktualisiert. Achten Sie beim Speichern des Plots als PDF-Datei darauf die richtigen
Dateinamen zu verwenden, um Verwechselungen mit älteren Konfigurationen zu vermeiden und prüfen
Sie vor der Ausgabe das Datum, um sicherzustellen, dass Sie den aktuellen Plot verwenden.

Warnung

Beachten Sie beim Aufbau unbedingt die Verfahren und Sicherheitshinweise, die in der Anleitung „K&F
SEQUENZA 10 N/W/B & Flugrahmen“ angeben sind.

Achten Sie beim Aufbau unbedingt auf die richtige Ausrichtung der Lastadapter in Bezug auf den Flug-
rahmen.
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9.1.1 Elemente�des�Plot�Ausdrucks

1. Name des Arrays, Anzahl und Typ der eingesetzten Lautsprecher

2. Name des Projektes

3. Erstellungsdatum des PDF

4. Position und Ausrichtung der Lastadapter

5. Linie des Schwerpunktes

6. Lautsprecher

7. Kontrollpunkt

8. Lautsprechermodell, Winkelungen und Controllerzuweisungen

9. Bezugspunkt des Arrays

10. Hinweis auf eingehaltene Normen
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9.2 Aufbau�prüfen

Der Setup Plot enthält Angaben mit denen Sie den richtigen Aufbau und die Verkabelung überprüfen
können.

• Der Kontrollpunkt auf dem Setup Plot dient zur einfacheren Überprüfung der Position des Ar-
rays. Prüfen Sie, ob Ihre Messung der Position und der Winkelung des untersten Lautsprechers
mit den Angaben auf dem Plot übereinstimmen.

• Prüfen Sie, ob die Kabelverbindungen korrekt erstellt wurden und ob der angegebene Controller
oder ein vergleichbares Gerät verwendet wurden.

9.3 Simulationsergebnis

Sie können das Simulationsergebnis in einem separaten Fenster anzeigen und ausdrucken.

1. Gehen Sie im Menü auf [View -> SPL Simulations], um sich das detaillierte Simulationsergebnis
anzeigen zu lassen.

Die Angaben auf dem Simulationsergebnis entsprechen denen in der Software selbst.

2. Mit der Schaltfläche [Create PDF] können Sie ein PDF des Simulationsergebnisses erzeugen.

9.3.1 Schallmesspunkte

Im Simulationsergebnis können Sie einzelne Punkte setzen, um den Schalldruck (dB) zu prüfen.

1. Klicken Sie auf einen beliebigen Punkt innerhalb der Schallverteilung. Der Schallpegel wird direkt
angezeigt.

Mit [Delete last] bzw. [Reset all] können Sie den zuletzt gesetzten Punkt oder alle gesetzten Punkte
löschen.
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9.3.2 Elemente�des�Simulationsergebnisses

1. Angaben zur Zuhörerfläche

2. Name des Projektes

3. Erstellungsdatum des PDF

4. Winkelungen der Lautsprecher

5. Angezeigte Frequenz

6. Schallskala

7. Messpunkt

8. Hörerfläche
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10. EASE�Export

Diese Funktion erlaubt es Ihnen Daten mit allen Informationen für Arrays und Hörerflächen nach EASE
zu exportieren.

Unter [File] > [Export to Ease >] > können Sie auswählen, ob Sie das aktuell ausgewählte Array [Actual
Array...], alle erstellten Arrays [All Arrays...], oder das Venue [Venue: Plane(s) & Array(s)] (Alle Arrays und
Hörerflächen) exportieren möchten.

Haben Sie die Auswahl getroffen, so öffnet sich ein Dialogfenster, das Sie fragt welche Art der Pegelsi-
mulationmit den exportierten Daten im EASE durchgeführt werden soll.

Durch Klicken der entsprechenden Schaltfläche entscheiden Sie sich entweder für eine [Max. SPL]-, [Pro-
gram]- oder [RMS]-Simulation.

Die�aktuelle�Programmversion�von�EASE�erlaubt�es�nicht�zwischen�den�verschiedenen�Pege-
leinstellung�umzuschalten.�Daher�gibt�die�CON:SEQUENZA�Software�dem�User�die�Wahl�die
Daten�für�die�jeweils�gewünschte�Simulationsweise�zu�exportieren.

Haben Sie sich für eine Pegeleinstellung entschieden, so öffnet sich ein Fenster mit dem Sie den Dateispei-
cherort und den Dateinamen bestimmen können. CON:SEQUENZA merkt sich den Dateispeicherort für
den nächsten Exportvorgang.

Nach dem Exportvorgang zeigt Ihnen CON:SEQUENZA welche Dateien generiert wurden und an wel-
chem Dateispeicherort sie sich befinden.

10.1 Importeinstellungen�in�EASE

1. Erstellen Sie in EASE ein neues Projekt.

2. Öffnen Sie das Fenster [Edit Project Data]

3. Deaktivieren Sie die Funktion [Room symmetric] und drücken Sie anschließend auf [OK]
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Diese Maßnahme ist notwendig, damit das importierte Array sichtbar wird (In EASE sind alle Array
Gehäuse unsymmetrisch definiert).

4. Schließen Sie das Fenster [Edit Project Data]

5. Öffnen Sie im Menü des Ease-Hauptfensters [File] > [Import / Export]

Das EASEIMEX Fenster öffnet sich.

6. Im Menü des EASEIMEX Fenster öffnen Sie: [Tools] > [Import ASCII] > [Loudseakers]

7. Laden Sie die aus CON:SEQUENZA exportierte Datei mit der Endung *.xld

8. Möchten Sie auch Hörerflächen importieren, so laden Sie diese unter: [Tools] > [Import ASCII] >
[Audience Areas] und wählen Sie die aus CON:SEQUENZA exportierte Datei mit der Endung *.xar.

9. Schließen Sie das Fenster [ESASEIMEX]

10. Öffnen Sie das Fenster [Edit Project Data]

11. Wählen Sie im Hauptfenster einen Lautsprecher aus und drücken Sie die Funktionstaste [F4].

12. Drücken Sie unter [Speaker Model] den Knopf […]

13. Laden Sie im Fenster [Choose Speaker Model] die gewünschte SEQUENZA 10 GLL aus der Lautspre-
cherdatenbank und drücken Sie [OK].

14. Gehen Sie wieder in das Lautsprechereditierfenster und drücken, falls vorhanden, auf die Schaltflä-
che [Dll/Gll Setup]

15. Drücken Sie die Schaltfläche […], um die Sequenza GLL zu öffnen.

16. Klicken Sie auf die Schaltfläche [Import] und wählen Sie die gewünschte *.xglc Datei für den Import
aus.

17. Schließen Sie die SEQUENZA 10 GLL.

18. Um weitere Arrays zu zu importieren, wiederholen Sie die Schritte 11 bis 17.

11. Lizenzvereinbarung

Bitte beachten Sie die Lizenzvereinbarung während der Installation.

Die Lizenzvereinbarung finden Sie außerdem im Installationsverzeichnis Ihrer CON:SEQUENZA Software.
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